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Many projects include images or items that are too big to fit on regular scanners 
or Scribes.  Scanning these items on the foldout machine can quickly become a 
hassle, and the resulting images will not be as high quality as those scanned on the 
flatbed.  For flat items like paper, it is much easier to scan the different sections of 
the item separately on the flatbed and then combine them in Photoshop! It is for 
this reason that I have created this writeup, for the convenience of all! 
 
Here, I have a lovely image of a cat, which I would like to put on the internet. 
Unfortunately, this image is in two parts. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

There are two ways I can remedy this situation and combine the two images: 
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Method One: Let the computer do it. 
With this method, we will tap into the glorious power of preprogrammed 

Photoshop tools. 
 
 

1. Drag the photo files you would like to stitch into Photoshop. 
(make sure these are the only open images. You can check which files are 

opened at the top bar circled in red) 
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2. From the top menu, select File> Automate>Photomerge 

 
 

3. In the photomerge menu, click “Add Open files” 
Make sure the following are also selected 

-Layout: Auto 
-Blend Images Together 

-Geometric Distortion Correction 
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4. Then click OK, and let Photoshop work its magic! 
When it’s done, you should have a lovely large image looking something like this: 

 

 
 

5. Examine the image by turning on/off layers 
On the right hand side, you can see the image layers that were blended together.  
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Click on the “eye” icon to turn the layers on/off. 

 
 

 
 

By turning off the layer, you will be able to see exactly where Photoshop blended 
the image. Zoom in, turning the layer on and off the ensure that the seam of the 
image blended properly. (Photoshop usually does a good job on simple images 

like this!) 
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6. Flatten Image 

 
 

When you’re sure the image is stitched properly, hold shi� and select all the 
layers. Right click, then hit “Flatten Image”, save, and you’re done! 

 
 
 

Continue below to learn how to  stitch by hand. 
 
 

Tips  for Scanning Documents in Sections 
 

In order to get the best stitch out of your images, there are a few rules it is good to 
take note of when scanning on the flatbeds. 

 
1.Flatten out all creases before starting. 

This is especially applicable to items like newspapers, which crumple easily. 
Unless unfolded, creases can obscure text, or even fold differently between scans, 

making the final stitched image look funny. 
 
 

2.  Always scan an overlap.   
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Notice: with these two cat images, a portion of the center of the original 
photograph is the same in BOTH images. This person scanned an overlap. This 
way, Photoshop knows where to best auto-stitch these two sections, based on the 

overlapping patterns.  Implement this technique when scanning!  Make sure all of 
your scans contain a little of the same information. 

 
3. When scanning with color targets, you only need one. 

It seems simple enough, but it’s easy to forget when scanning something big like a 
newspaper or a poster.  You only need a color target on the first scan! 

 
4. DON’T change the size of your crop box between scans if you can help it! 
Having to change the scale of images if you end up stitching by hand is a real pain. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Method Two: Do it by hand! 

 
 
Photoshop’s Photomerge will work with ANY number of images, not just two! 
There are, however, some flaws to this method.  Photoshop merges photos by 
searching the images algorithmically for similar patterns and then aligning them. 
This means it needs something to work with.  Trying to stitch together a fairly 
blank piece of paper (like below) is much harder for photoshop to do. 
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This method is a little bit longer and a fair bit more complicated, but while it may 
not be more convenient than shooting on foldouts,  it will produce much better 
quality images,  and will work on documents that are too big for even the foldout 
station. 

 
1. Start by opening up one of the scans in Photoshop.  Then drag the second 

image you want to stitch  directly on top of the opened image  in photoshop. 
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You should see your new image placed on top of the original, and a new layer 
added on the right. Hit  enter  to place the file.  

 
2. Adjust the Canvas 

 
Select the Crop tool on your toolbar.  
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With the crop tool, drag the edge of the image in whatever direction you will need 
in order to fit the second image. In the example, I dragged the 
canvas to the right so I can fit the right side of the cat’s face in the frame.

 
 

3. Move the layer with Transform Tools 
Select the layer you need to move, then grab the transform tool. 

 

 
 

By clicking and dragging, you can move whatever layer you have selected. Move it 
roughly to where you think it should be. Then press  enter.  
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4. Line up the layers more accurately by lowering the Opacity.  
 

Now that we have the image in place, we can go through and line up the layers 
exactly.  In the layer settings for the new layer you just placed, go and turn down 
the opacity to about 50%.  This will allow you to see exactly what the layers look 

like where they overlap. 
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As you can see, my images aren’t perfectly aligned.  Because of this, the middle of 

the image appears fuzzy, and you can see double copies of everything. 
 

 
To fix this,  Select the top layer and use the  transform tool  again. Instead of 

dragging with the mouse, you can use the  arrow keys  to make minute 
adjustments until the image is perfectly sharp and the layers are aligned perfectly 
(see below).  You should zoom in close to check your work. When you’ve finished 

the transform, press  Return . 

 
Now that the images are aligned properly, we’ll turn the opacity on the top layer 

back up to 100% and take a look at the finished product! 
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On closer inspection of my image, I can’t find any hard lines or distortion along 
the seam between the two layers, but o�en your real life scans won’t line up this 

perfectly, so continue to learn about more tools to fix it! 
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Helpful Tools: 
 

Layer Masks 
 For fixing  seam lines or distortion along the layer edges 

 
Layer Masks:   allows you to “mask” out parts of a layer, which is kind of like 
erasing--except the parts you erase don’t permanently disappear, so you don’t lose 
any image data if you make a mistake. 

 
1. Create a Layer Mask 

 
With the top layer selected, you’ll want to click on this button down here, 

which will create what’s called a  “layer (or vector) mask”  on that layer. 
 

 
You will get a blank white layer that pops up next to the one you have selected: 
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2. Select Brush and adjust brush settings 
 

Switch to the brush tool (hotkey  B  on the keyboard), make sure your foreground 
color is set to black: 

 
 

If your brush tool is selected, you can change its settings on the top le� of the top 
bar.  Set it to a hardness of 0% and an opacity of 50% or lower.  
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3. Paint along seam line 
 

Find a seam line (where your layers overlap), and start painting along it until the 
images blur smoothly into each other.  You want it to look like it was scanned as 

one image! 
 
 

EXAMPLE: 
Before: 

 
A�er: 

 
Much better, yeah? 

 
4. Flatten your image, by right clicking on one of the layers and selecting 

“flatten image”. 
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~Layer mask painting tips: ~ 

● Always make sure the layer mask (white box next to the layer) is selected. 

Otherwise you will paint on the image itself. 

● Painting with  black  will erase the layer 

● Painting with  white  will bring the layer back 

● Press ‘D’ to instantly make the foreground color black and background color 

white 

● Toggle the foreground/background color with ‘X’ 

 
 
 

Puppet Warp 
For slightly moving and shi�ing pixels without damaging the entire image. 

 
Puppet Warp:  A tool that lets you place pins and move the pixels around those 

pinss 
 
 

Lining up small portions of images: 
 
Here is a map that Photoshop has photomerged.  
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However, closer inspection shows that there are small parts that Photoshop has 
not lined up correctly.  
 
 

 
 
 
This is how we will fix it with Puppet Warp! 
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1. Merge the Layers  (don’t flatten--save that for the very end, when all fixes are 
done) 

 
 
 

2. Use Polygon Lasso Tool  to select an area that you want to move. (Lasso Tool 
could work too. However, Polygon Allows you to select with straight lines. 
Click to place edges of your selection, and double click to close the 
selection)  
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Here I selected the entire right portion of the line so I can slightly move the whole 
thing. If I selected only part of this line, I would create even more discrepancies. 
Select from edge to edge! 
 

 

 
 
 
3. Duplicate your selected pixels onto a new layer 
 
I don’t want to start moving the pixels on my original layer. Otherwise, it would 
start showing the transparent background underneath and damage my original 
image. New layers are always safer! 
 
With the desired area selected, click “Command J” and your selection will now be 
isolated on its own “Layer 1” in your layers panel. This is what we will be moving.  
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4. Select Puppet Warp to use on your new layer 

 
Edit > Puppet Warp 

 

 
 
 

You’ll get a weird-looking grid around your layer: 
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5. Place pins and move! 
 
Important notes on how pins work:  Wherever you place a pin, it will “glue” down 
that area of pixels--only the activated pin will move. You activate a pin by clicking 
on it and a little white circle will appear in the middle. Use the  arrow keys  to 
move your activated pin. You will notice that the other pins don’t move.  

 
 

 
 

 
This part is a trial and error game--try moving different pins up and down slightly 
until it looks right! Placing more pins will make the movements smaller and more 
restricted, so use as many as your situation calls for. It is o�en safe to place pins at 
the top and bottom (or start and finish) of an area that you want to move, such as a 
line, like above. That way, the entire line won’t get too warped as you move pins. 
 
6.  Hit Enter to finish puppet warp, merge layers, and repeat for all areas that 
need it! 
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Lining up entire layers 
 
So I’ve followed the “Do it by hand” method, and there are still small parts of the layers that are not 
lining up correctly. I can see the discrepancy here when I turn the  opacity down  on one layer. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

I can use puppet warp to nicely put those areas back in place! 
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1. Click on the layer you want to move, turn the opacity down, then go Edit>Puppet 
Warp, and place pins where you DON’T want to move 
 

 
 

 
 

2. Place pins near the areas you want to nudge. Use the arrow keys on your activated 
pin and move it until it lines up with the layer underneath it. 
 
 
WARNING: If you don’t have enough pins gluing the rest of your image down, 
those other areas will start to move too! Always keep an eye on how 
everything  moves when you move  pin. 
 
Pro­tip:  Lining up the edge/seam of the layer is the most important part‐‐that 
is where we will blend with a layer mask, so we need the seam to be perfect. 
Areas farther away from the seam/edges will not be noticeable once you turn 
the opacity back up. 
 
3. Confirm your puppet warp with Enter and blend seam with layer 
mask. 
See Layer mask portion for more help with blending seams.  
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Correcting bent/ droopy scrolls 
 
When photoshop merges images that are really long or wide, like scrolls, it has a 
hard time keeping it straight. We will be using puppet warp on a much larger scale 
for this process. Review the process above for more details on how the tool works.  
 
 
Here are few stitches that Photoshop has tried to merge. For whatever reason, it’s 
drooping.  

 
 

1. Merge layers 
 

2. Grab puppet warp 
 

For this process, it’s ok to use puppet warp on the original layer since we are 
working with the  whole  image 
 
     3. Place pins 
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For this example, I placed a lot of pins on the le� side of the image because I don’t 
want that area to move. I placed one pin in the middle of the area I want to adjust, 
which is near the right end. 
 
 
4. Adjust with arrow keys 
 
Just by pressing up on the arrow key, I was able to move this entire portion up 
without distorting the rest of the image!  
 
 

 

 
   
Crop and flatten to finish! 
 

Transform Tool 
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For moving pixels side-to-side or up-and-down  
 

Puppet Warp works great when you need to finely bend pixels, but sometimes you 
need to move things directly sideways or up/down. Transform tool is your best 

tool to move pieces as a whole. 
 

Here is a map that photoshop stitched. 

 
However, closer inspection shows that some edges didn’t line up well. 

 

 
 

Rather than use puppet warp to bend in the edge into become flush, I’m going to 
move an entire piece with transform tools. 
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1. Select area you want to move with Polygon Lasso Tool 
 
Selection is easy for this piece because the map and background are plain in 
this area. I’m not ruining any text or information if I move this area. Be 
aware of your selection, because you don’t want to displace important 

information! 
 
 
2. Duplicate the Selection onto its own layer with 
Command+J 
 
3. Grab the transform tool 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4. With the new layer selected, click arrow keys to 
start moving the pixels. 
 
For this example I moved the entire selection to 
the le� a little until it was in line with the upper 
edge. It only took about 3-4 le�-arrow clicks.  
 

 
5. Use Spot Healing Brush to fix any 
blemishes 
 
Now that they are in line, we might 
need to fix little discrepancies that came 
with the move.  
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The Spot Healing Brush Tool  : references pixels nearby and fills in wherever you click with 
similar looking pixels. 

 
 
Grab the little band‐aid with a dotted circle 
around it (not to be confused with the normal 
Healing Brush Tool) 
 
Just click on any area you want to heal! Use a 
fairly  small  brush size.  
 
 
 

 
 
 
 
Healed! 
 
 
 
 
 
 
 
 
 

 
6. Merge Layers and finish! 
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Inserting Black Backgrounds 
 
Because we might scan stitches that have different amounts of black background 
showing, a photomerged image will not give an even amount of black background 
around all sides.  
 
Here is a document that was stitched by Photoshop. You can see that the stitches 
had all different sizes of black border, and we can’t get a good crop from this: 
 
 

 
 

1. Merge layers ( don’t flatten) 
 
Shi�+ select all layers, then right click over a layer and click “Merge Layers”.  
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2. Grab the Wand Tool 
 

 
 
Wand tool: selects pixels of similar color that are next to each other.  
 
3. Click on any area of the black background.  
 
You should see “marching ants” appear around the black background. It’s ok  
if it doesn’t cover 100% of the background--just as long as it gets most! 
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4. Refine Selection with “Select and Mask” (very important or your 
selection will look really jagged) 
 
With wand tool still selected, click “Select and Mask” on the top menu. 
When the new menu opens, head to the right hand side and change the 
following: 
 
Smooth slider: 10 
Contrast: 4% 
 

 
Press ok. 
 
5. Invert the selection 
Go to Select>Inverse OR press Shi�+Command+I 
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6. Add a layer mask with the current selection 
 
 

 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
Now you should see your image with the background (mostly) cut out and a 
transparent background. You should also see a black and white layer mask next to 
layer thumbnail.  
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7. Paint out any remaining background    
 
Press B to select the brush tool, make sure your layer mask is selected and that 
your foreground color is black. (See the Layer mask portion of this write up for 
more help) 
 
Paint away any residue!   
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 8. Insert a new background file.  
 
 

A. Choose an appropriate size of background. The specs for the backgrounds 
are in the file name.  

 
Warning: the 400 ppi tif backgrounds are HUGE. They may take a while to manage.  
 

B.  Drag the file from finder  directly onto your image 
 

 
 
 
 
 
C. Move the black background layer UNDER your original layer 
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Now we have a lot more background to work with, and cropping will be much 
easier.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 


